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TechnoResearch, Inc.
Software License Agreement

IMPORTANT - READ CAREFULLY
This is a legal agreement between you (either an individual or an entity) and
TechnoResearch, Inc. By opening this sealed disk envelope, you are agreeing to be
bound by the terms of this License Agreement. If you do not agree to the terms of
this agreement, promptly return the unopened software package(s) and accompany-
ing materials to the place you obtained them from for a full refund.

1. User License - This is a user license agreement, and is not an agreement for
sale. TechnoResearch, Inc. grants you the right to use one copy of the enclosed
Win Pro-Flo software program, documentation and other related materials (the
“Software”) subject to the terms and conditions of this Agreement.

2. Copyright - The Software is owned by TechnoResearch, Inc.  and is protected
by both United States copyright law and international treaty provisions.
TechnoResearch, Inc. retains all title to and ownership of the Software. All copies,
modifications, adaptations, translations or derivative works of the Software, in
any form, remain property of TechnoResearch, Inc. which retains all rights not
expressly granted herein. Nothing in this Agreement constitutes a waiver of
TechnoResearch, Inc. rights under U.S. copyright laws or applicable international
treaty provisions. Any violations of this Agreement shall constitute termination of
the license, and may subject the violator to legal prosecution.

3. Use of the Software
- You may copy the software to a hard disk and use the

Software.
- You may make backup copies of the Software for archival

purposes.

4. Restrictions of Use
- You may not distribute, in any form, any source code, linkable object

code, or any portions of the documentation.
- You may not include any of the Software functions in a programming

toolkit or library, or in any application that is a tool to be merged into
another application program.

- You may not remove or obscure TechnoResearch, Inc.  internal copyright
and trademark notices.

- You may not reverse engineer, decompile or disassemble the Software.

5. Limited Warranty - With respect to the physical disk(s) and documentation,
TechnoResearch, Inc.  warrants the same to be free from defects in materials and
workmanship for a period of 30 days from the date of purchase. In the event of
notification within the warranty period, TechnoResearch, Inc. will replace the defec-
tive disk(s) or documentation.

6. Limitation of Liability - TechnoResearch, Inc. specifically disclaims all other
warranties, expressed or implied, including but not limited to implied warranties of
merchantability or fitness for a particular purpose. In no event shall TechnoResearch,
Inc. be liable for any loss of profit or any commercial damages, including but not
limited to special, incidental, consequential or other damages arising out of the use
or inability to use the Software. The entire risk as to the results and performance
of the Software is assumed by you.
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CHAPTER 1

ABOUT Win Pro-Flo

Introduction
The Win Pro-Flo is a user friendly software tool able to diag-
nose and calibrate engines.

This Windows based program was designed to communi-
cate with a Magneti Marelli Q13 ECU .
The interface between the ECU and the PC is through an
RS232 interface box. The graphic user interface (GUI) with
the help, hotkey, and mouse support will provide a user
friendly system.

The main graphic user interface (GUI) consists of a pull-
down menu and a tool bar. The execution of the menu items
are in the form of numeric controls, commands button con-
trols, pop-up panels and others.

About this Manual
The Win Pro-Flo User’s Guide is a comprehensive guide
that contains all of the procedures you need to work with
this software. To help you get familiar with the Win Pro-Flo
and learn efficiently how to operate it, this manual is orga-
nized by chapters that describe the use of the software and
the commands general description.

Many aspects covered in this manual are also described in
the help menu, which is available in the program itself.
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System Requirements
In order for this software to perform as expected, the following
system configuration is required:
- IBM 486 (or better) or compatible PC with a minimum of 8MB
of RAM, although 16MB is recommended.
- VGA Monitor, SVGA monitor or better.
- Windows 3.1, Windows 95, Windows 98 and Windows NT.
- Win Pro-Flo installation diskettes for    Windows.
- Software security key.
- Communication cable.

Special Terminology

WIN PRO-FLO. Win Pro-Flo.
ECU. Electronic Control Unit.

Technical Support
You can reach TechnoResearch’s technical support depart-
ment in any of the following ways:
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GETTING STARTED

Installing the WIN PRO-FLO

1. Make a backup copy of the diskettes for safety
       purposes

2. Insert Win Pro-Flo for
Windows install Disk  in your computer’s floppy disk
drive.

3. In Windows 3.1, choose the Windows Program
Manager..

4. In Windows 3.1, from the File menu of the
Program Manager, choose Run. In Windows 95,
click the Start button and then choose Run.

5. Type a:setup if  you are installing from the
Drive A, or b:setup if you are installing from
Drive B. Click O.K. to continue.

6. Follow the installation instructions.

To install a Sentinel System Driver:

1. Make a backup copy of the diskettes for safety
       purposes

2. Insert Win Pro-Flo for
Windows install Disk  in your computer’s floppy disk
drive.

3. In Windows 3.1, choose the Windows Program
Manager..
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4. In Windows 3.1, from the File menu of the
Program Manager, choose Run. In Windows 95,
click the Start button and then choose Run.

5. Type a:RainbowSSD5.39.2 if  you are installing from the
Drive A, or b:setup if you are installing from
Drive B. Click O.K. to continue.

6. Follow the installation instructions.

WIN PRO-FLO Set up
1. Attach one end of the adapter cable to the DB-9 con-

nection port of the computer. Attach the other end of
the adapter cable to the data link connector located on
the motorcycle.

NOTE: When unplugging the DB-9 connector, DO NOT
pull the cable, grasp the connector to prevent damage.

2. Turn the ignition switch to the “Ignition” position
and turn the engine stop switch located on the handle bar
to the “Run” position.

3. Attach the hardware key to the parallel port of the com-
puter.

Starting the WIN PRO-FLO
Once you have successfully installed the WIN PRO-FLO, you
can run it by double clicking the file “diagtool.exe”. A multilingual
screen will come up in order to begin using the software (see
multilingual screen in the next page).

Where to go from here
To get help using the WIN PRO-FLO, press F1 or click on the
contents icon with the left button of your mouse at anytime.
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USING THE WIN PRO-FLO

Data Monitoring
In order to display the data you wish to monitor, you have to
establish connection with the ECU and set the program either in
dashboard mode or strip chart mode.

To establish communication use the connection command by
either clicking on the communication icon or using the commu-
nication menu.

Once communication is established, the data can be monitored
through a strip chart as shown in Chapter 4.

While in strip chart mode, you can select the data you want to
be displayed using the channels/view command and setting them
in on or off position.

You can also change the colors of the lines of the strip chart
using the colors command.

The same data can be shown using the dashboard monitor by
clicking on the dashboard icon or using the dashboard option in
the communication menu. This option enables you to display
the data in a variaty of graphical forms, as shown in chapter 4.
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When communication with the ECU is lost or could not be es-
tablished, the data would not be available to be displayed and
the following error message dialog box will come up:

Checking Diagnostic Trouble
Codes (DTC) & Lambda Status
If you are connected and monitoring data through the strip chart
or the dashboard, you can also check if there are any input,
output or function errors in the system.

To do so, use the system error command and the screen shown
in chapter 4 will appear.

This screen would show you exactly what part of the motorcycle
is not working properly and it needs to be fixed.

Likewise, if you wish to know the System Status while using the
software, just click on the system status icon respectively or
use the system status command in the monitor menu. Refer to
chapter 4 to see details regarding the systems status screen.
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Opening, Closing and Saving a
Data File
If you want to check and open an old file, use the open
file...command and the following screen will be activated for you
to select the file you wish to review:

In order to open a file you have selected, double click on the file
and then hit the OK button.

Then, a strip chart with the data you want to be displayed will
appear. Refer to Chapter 4, Open File... command for more de-
tails.

When working on an old file, you can also use the channels/
view and colors command as described in the Monitoring Data
section.

To close an opened file you can either use the close window
command or go to any other screen and the file would be closed
automatically.
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In order to save or log a data file, you have to use the strip chart
command and get connected with the motorcycle’s ECU to be-
gin monitoring the data you want to start logging on.

Once connected, use the log on command to start saving the
data and the log off command to finish with the data file saving
operation.

The name of the files would be automatically assigned by using
the current date with a log extension. An example of a file saved
on July 24th, 2001 ;could be: 07242001001.log.

If you have saved several files in the same day, a consecutive
sequential digit would be assigned to the file, such as,
07242001002.log and so on.

If you wish to retrieve a file you have saved, proceed as de-
scribed in the beginning of this section.
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CHAPTER 4

GENERAL DESCRIPTION

Win Pro-Flo Main Menu
The WIN PRO-FLO offers a main menu, which offers a variety of
commands described in the following chapter:

File Menu. Displays a menu with commands to
open a file, export to ASCII, print,
close an active window and quit
the program.

Monitor Menu. Displays a menu with commands
related to data monitoring.

Edit Menu. Displays a menu with commands
related to calibration files.

Communications Menu. Displays a menu with commands to
connect to the ECU, disconnect
from the ECU and select port set-
tings.

Reflash Menu. Displays a menu with a list of
command related to downloading,
uploding, storing and restoring
calibrations.

Options Menu. Displays a menu with a list of com-
mands to select log settings, log on
or log off, select the ECU type, se-
lect channels, units and color
settings.

Help Menu. Displays a variety of help commands
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Win Pro-Flo Menu Bar.

The menu bar located at the top of the WIN PRO-FLO window
allows you to display the commands on each menu either by
the use of the mouse or the keyboard.

To open the menus and look at the commands, drag across the
menu bar with the mouse by pointing to the menu name and
clicking the left mouse button, or press the ALT key, and then
press the underlined letter in the name of the menu you want to
open.

The menu bar consists of the following pull down menus: File,
Monitor, Communication, Options, Utilities and Help.

The Toolbar
This toolbar contains buttons that help you complete your most
frequent actions, by simply clicking a button with a mouse.
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File Menu Commands
The file menu contains a variety of commands which are used to
view data for post analyses, close an active window and exit
from the program. These commands are listed and described
below as follows:

New...   Allows the user to create a new calibration file.

Open...  Allows the user to open an existing calibration file.
             A dialog box will appear to specify the selected file.

Save As...  Allows the user to save a calibration file.

Open Data Analysis...    Allows the user to open a log file.

Export to ASCII.Creates an ASCII file from a log file.

Print.                 Prints the active window

Close Window. Closes the active window

Exit.                   Allows the user to quit the program at
                          anytime.
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 Open Data Analysis... command

The Open... command is used to view data for post analysis.
The following screen represents a data file opened by using this
command:

Data Description

RPM: Engine RPM numeric value.
Battery: Battery voltage numeric value.
Spark Advance: Spark adv. angle numeric value.
Pulse Width: Pulse width numeric value.
Throttle Position: Throttle angle numeric value.
Air Temperature: Air temperature numeric value.
Idle %: Idle % numeric value.
VAC: Vaccume numeric value.
Target RPM: Target rpm numeric value
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Special Functions Description

Zoom In (+):  Zooms in to the graph by clicking with the
mouse on the zoom in button.

Zoom Out (-): Zooms out of the graph by clicking with the
mouse on the zoom out button.

Scroll (↔↔↔↔↔): Scrolls through the graph by clicking with the
mouse on the left or right arrow.

Monitor Menu commands
The Monitor Menu displays a menu with commands used to
view data in several forms and test actuators. These commands
are described below:

Gauges/Meters Monitor. Displays data in real time in a
gauge/meter form.

Strip Chart Monitor. Displays data in a strip chart form.
You can log ON/OFF and turn
trigger settings from this data monitor
window.

System Errors. Displays the Diagnostic Trouble Codes.

System Status. Displays the current lambda status.
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 Gauges/Meters monitor com-
mand

The Gauges/Meters monitor command opens up a window, which
enables the user to view data through bar slides graphs, ther-
mometers and check lights.

Data Description

RPM: Engine RPM numeric value.
Battery: Battery voltage numeric value.
Spark Advance: Spark adv. angle numeric value.
Pulse Width: Pulse width numeric value.
Throttle Position: Throttle angle numeric value.
Air Temperature: Air temperature numeric value.
Idle %: Idle % numeric value.
VAC: Vaccume numeric value.
Target RPM: Target rpm numeric value



                        Win Pro-Flo  User’s Guide

19
________________________________________________________________

Chapter 4

 Strip Chart monitor command

The Strip Chart monitor command is used to view data in line
plot and numerical form.

Data Description

RPM: Engine RPM numeric value.
Battery: Battery voltage numeric value.
Spark Advance: Spark adv. angle numeric value.
Pulse Width: Pulse width numeric value.
Throttle Position: Throttle angle numeric value.
Air Temperature: Air temperature numeric value.
Idle %: Idle % numeric value.
VAC: Vaccume numeric value.
Target RPM: Target rpm numeric value.
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 System Error command

The ECU saves an error in memory if it detects a sensor related
problem. Then, the WIN PRO-FLO will display both current and
historic errors in the following screen:

When a sensor related problem exists, the following error mes-
sages would appear for any of the next parameters:

Map Sensor
H2O Temperature Sensor
Voltage High/Low
Throttle Input Sensor
Air Temperature Sensor
O2 Sensor

Screen buttons

O.K. Closes the dialog box and completes the
command using the selected options.
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 Lambda Status Command

The Lambda Status Command displays a window, which shows
all the lambda flags.

Screen buttons

O.K.: Closes the dialog box and completes the
command using the selected options.
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Communication menu commands
The Communication menu contains a variety of commands which
are used to connect and disconnect the communication from
the controller. These commands are listed below:

 Connect. Establishes connection with the ECU
being used.

 Disconnect. Terminates communication with ECU.

 Port Setting. Offers a list of RS232 serial ports to

select.
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Off-Line/Real-Time Calibration
Command
The Calibration Off-Line Command displays a window, which
shows the fuel table, spark table, miscellaneous and note infor-
mation pertaining to the Calibration.
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Screen buttons

O.K.: Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected,
closes the dialog box and returns to the
previous screen.

Graphs: Graphs the fuel and spark table data
in a three dimentional form.

Clear All: Clears all the fields in the Panel.

Print: Prints the active window.
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Store ECU Calibration Command
The Store ECU Calibration Command displays a window, which
shows all the options in which you can store the calibration to.

Screen Buttons

O.K.: Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected,
closes the dialog box and returns to the
previous screen.
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Restore ECU Calibration Command
The Restore ECU Calibration Command displays a window, which
shows all the options in which you can restore the calibration
from.

Screen Buttons

O.K.: Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected,
closes the dialog box and returns to the
previous screen.
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 Port Setting command

The Communication Port command displays a window that en-
ables the user to select the RS232 communication port.

Screen Buttons

O.K. Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected, closes
the dialog box and returns to the previous screen.
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Options menu commands

The Options menu contains a variety of commands that allows
the user to select several options such as scale adjusting, color
settings, ECU types, log settings, Units settings, calculator and
units converter.

 Channels/Mode command

The Channels/Mode command activates the following screen:
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Channels Features

In the channels section of this window you can activate or deac-
tivate any of the parameters when performing the monitoring by
setting them in off or on mode.

In the Min. and Max. fields you can set the minimum and maxi-
mum scale values to set monitor data graph.

View Mode Features

Parallel: Activates an individual chart for each channel  to
be displayed in the same screen using indepen-
dent scales for each parameter.

Overlay: Activates the overlay mode, showing all the
parameter graphs using the same scale for each
of them.

Defaul: Sets the default Min. Max. scale values.

Screen buttons

O.K.: Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected, closes
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 Color command

The Color command displays a window that allows you to select
the different color settings for the strip chart.

To change a color setting for any of either the graph or trace
parameters, just click on the bar color you wish to change, keep
the left button of the mouse pressed and select the color that
you choose from the displayed palette.

Screen buttons

O.K. Closes the dialog box and completes the
command using the selected options.

Cancel Discards the options you have selected, closes
the dialog box and returns to the previous screen.
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Log Settings command
The Log Settings command allows the setting up of the data
capturing. The triggering can be set up automatically to capture
as many data points as specified in the Log Data Points field
when an error event is set. The data can be recorded in three
different ways (start, middle and end), from the moment of the
trigger, half the data points before the moment of the trigger and
half the points after the trigger, or all the data points that pre-
ceded the trigger.
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Log File Features

Browse: Allows the selection of a file name

Trigger Features

Mode: Sets the mode in which the data capturing
is going to be triggered.

Error Event/Ecu  Datat:
Displays a list of error events in order to
set up the triggering everytime the chosen
error occurs.

Trigger Position: Allows the set up of the three different ways
that data can be captured.

Screen buttons

O.K.: Closes the dialog box and completes the
 command using the selected options.

Cancel: Discards the options you have selected, closes
the dialog box and returns to the previous screen.
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Unit command
The Unit command offers a window to select the type of unit
system.

Options

(°F, inHg) Displays the data using the English unit
system.

(°C, mmHg): Displays the data using the SI unit
system.

Screen Buttons

O.K.: Closes the dialog box and completes the
command using the selected options.

Cancel: Discards the options you have selected, closes
the dialog box and returns to the previous screen.
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Utilities Menu Commands
The Utilities Menu displays the Calculator command and the
Units Conversion command both are for general purposes cal
culations.

  Calculator command

The Calculator command activates a calculator for general pur-
pose calculations.

In order to perform calculations, you can use either the mouse
or the keyboard.

Screen buttons

OFF: Deactivates the calculator and exits this window.
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 Unit Conversion command

The Unit Conversion command displays a window that con-
tains the most used units conversions for general purposes.

Screen buttons

Exit: Discards the options you have selected, closes
the dialog box and returns to the previous screen.

Default: Closes the dialog box and completes the
command keeping the conversions with the
new data entered by default.
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In order to provide assistance at anytime, the Help menu offers
the following commands:

Contents Offers you an index of topics on
which you can get help.

Search For Help On... Provides general instructions on
using help.

About Displays the version number of this
application.

 Contents command

The Contents command displays the Help screen. From this
screen, you can jump to step-by-step instructions for using WIN
PRO-FLO and various types of reference information.

Once you open Help, you can click the Contents button at any-
time if you want to return to the opening screen.

 Search For Help On... command

The Search For Help On . . .command offers instructions about
using Help.
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About command
The About command displays the copyright notice and version
number of your copy of Win Pro-Flo.


